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Abstract

New York is the largest cily in the United States. Imagine the
amount of waste New York City produces. In order to dispose of
the waste, the city must implement an effective recycling
program. The purpose of his research is o look into the costs
and effectiveness of current and pilot programs for recycling in
New York City. We looked further into recycing methods by
conducting anonymous surveys, collected statistics from NYC's

ent of Sanitation and statistics from Baruch College's
recycling pilot program. Based on the data we collected, our
results yield that peaple are open ta the idea of recycling and
would do o if given the opportunity. However, Implementing
street recycling bins is not cost effective in the short-run for the
city ™ -

-Methods

- Ananymous Survey in New York City
- Chinatown (40 Surveys)
- Fresh Meadows (40 Surveys)
- Flushing (50 Surveys)
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- Baruch College's Pilot Program
- Pilot Program: Removed Garbage in Classrooms and
Vividly Labeled Separate Receptacles in Main Afrium
- Data Collected From Before and After implementation of

new program

- Contacted Dr. Engle-Friedman, Chair of the Baruch Callege
Task Force on Sustainability

- Contacted Divya Dayal, Macaulay Inten

- New York City's Department of Sanitation
- Fiscal Year Reports on Garbage in New York Gty
- Extensive Study for 2004-2005 Year
- Collected Data from Department's Website

and Costs of Public Space Recycling in New York City

Tracy Dimaculangan, Rick Jean, Aaron Lam, Marcin Skok
Macaulay Honors College, CUNY Baruch College

Survey Data

Recycling in Specific Environments.

& No
& Yes

Baruch College’s Data

Comparison of Waste Recycled to Waste
Landfilled

= Waste Bound for the
Recycling Plant

# Waste Bound for the
Landfill

the landfill could have been
recycled through the current
waste management program

w York City’s Data

Costs for Refuse and Recycling after Removing

17 26% of the waste boundfor

Non-Curbside Related Activities
Curbside Curbside  Other Refuse Other
Refuse. Recycling
Total Costs $7783046000  §192590000  SET066000  §22,425,000
2,894,455 620,796 390412 72841
Cost/Ton 5 263 $ o 8 06§ E

Reasons for Not Recycling in Public

= N Bins
= Inconvenient.
# Other

2004-05 NYC Composition of
Street Basket Waste

mRacyclable
& Non-Recyelable

Results

- New York City residents overwhelmingly state that they do
recyche at home, In the workplacei/school and in public, though
less people recycle publily,

- The main reason residents do not recycle is because separate
receptacle are not available.

- Even prior fo Baruch's recycling awareness initiaive, 51% of
Baruch's total wasle was comprised of recyclable items. With
separate recycle bins available at the college, 50% of recyclable
waste was recycled properly

- Baruch's frash composition mirrors NYC's trash composition,
The ratio of non-recyclable waste to recyclable waste are nearly
identical.

- The cost of recycling is much higher than the cost of refuse
processing

Conclusions

Based on the data we collected and analyzed, Wwe conclude that:

- It would not be economically feasible in the short-run for New
York City to implement  separate receptacles for frash and
recycling.

- People are environmentally-conscious about recycling and
show interest In recycling. If they were given the option to
recycle in public spaces, more peopie woLkd do so.

- Meny people showed Interest in recycling for numerous
reasons.
- However. recycling curbside trash is not as effective due to the

relatively smali amount of trash collected from the strets,
contamination of recyciable trash, and limited technology.
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Whhere to start
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Brain storm ideas for what you want your poster to tell your
audience

Finalize your list to 2-4 key points

Define the title and sections

> Introduction, methods, results, discussion, summary, selected
references, etc.

Start selecting pictures, tables, charts etc. that you want to
include

Start planning the layout of your poster by sketching a rough
draft

Keep your key points in mind throughout this process )



Organization

» Poster starts in upper
left corner

» Typically, the flow
should be top to bottom,
left to right

&
| L

» Title-author(s)-sponsoring institution(s) header
should be at the top of the poster just under the
title

» Think about using things like letters, numbers
and even arrows to help direct the reader to the )
next section you want them to read
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\ Enter Title of the Research Here
» Tem P late Provi ded TUPUI StudentFirst LastName and Mentor LastName

Iurul
CENTER FOR

t Indiana University School of Nursing ot
O you Indiana University-Purdue University Indianapolis
> M u St be 3 2X4O an d m Review of Literature Current Status of
'y Put your abstract here. Provide a brief literature review, Research
p 0] rt ra |t Make sure you check the what is already known. Include here the status of
font sizes ,etc. your project,
Make sure to use important initial observations,
> Ca nn Ot use CO | or references. future directions,

problems encountered, etc.

background

> Must use logos for
IUPUI and CRL —

Brief introduction that should

p rOV| d e d on include the purpose or

research question of your

study and the significance of
template your study
> A” Other detalls are What did you do or plan to do?
editable at your P
data-gathering procedures, 1.Bartlett, R., M. Bussey, et al.
d |SC ret i on tests, etc. (2005). "Movement

variability cannot be
determined reliably from no-
marker conditions." J
Biomech.

2.Wilson, D. J., B. K. Smith, et
al. (1999). "Accuracy of
digitization using automated
and manual methods." Phys
Ther 79(6): 558-66.




Content

» Introduction/Background/Objectives:

+ This could be in addition to an abstract or in place of one

+ What is the state of the field? What made you ask the question
you asked?

+ Justify your study, give strong rationale
+ List objectives

» Methods

+ Provide only enough for credibility. You don’t have to explain
everything, just the high points required the main points of your
results.

» Results

+ Present relevant data

+ Integrate tables, graphs, photos )
+ Limit items in tables & graphs

+ Discuss only the pertinent points




Content

» Discussion/Conclusions:

+ Only the main points/ list them! What did your
results show? How did your results add to the
current field (outlined in the background section).

» Acknowledgements

+ Funding, collaborators, your lab trainer

» References

+ If you listed any references in your introduction or
methods sections or anywhere else in your poster,
you must list them on your poster.




O‘ Q Q
Stplicity
» Don’t present too much - you want to keep the

readers’ interest, not overwhelm them

» Concentrate on 2-4 key points (remember
those?)

» Use graphics as much as possible instead of text

» When possible, use bullets or outlines instead of
full sentences




Feaeings

» Highlight title, headers, and subheaders

+ Bolding
+ Contrasting color

+ Color blocking

» Make headers and subheaders at least 25% larger
that the regular text

» Be sure you can read all type from at least 6 feet
away

» Be sure everyone knows who did this work by
putting it under the title
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Expression, purification, and crystallization of recombinant

ABSTRACT
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et

» All text should be in short, concise
statements; minimize descriptive long
sentences

» Normally set line spacing on text at 1.5

» Size of text is very flexible but just as you
can make it too small, you are also make it
too big.

» REMEMBER - be able to read it from 6 feet
away
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QEDML: An XML Based Standard for Scientific Survey
Questionnaire Design and Deployment
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Graplhics

» Pictures can say a thousand words.

> Study system
> Microscopy images
> Special instrumentation

> Infection patterns

» But, make sure that your image says
something relative to your poster and your
2-4 main points!

» Always view images at ~125% to check for
pixilation.



Minimal Bioavailability of Aerosolized Tobramycin in the Sinonasal Tract:

A Safer Approach to Administration of Aminoglycosides for Sinusitis Exacerbations and

David Greena, MD, FACS.

Persistence in Patients Post-Endoscapic Sinus Surgery
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Aesthetics

» The purpose is to highlight your content

» Never have the aesthetics overwhelm the
main points of your poster

» Should grab people’s attention but not take
that attention away from your main points.

» Some white space is a very good thing,
necessary actually, but IT MUST BE
INTENTIONAL and BALANCED!




Low dose oral EtOH enhances socialization and collaborative projects among
scientists during a scientific conference
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Color

» Muted colors, or shades of gray, are
always a good choice for the background.

+ Use more intense colors as borders or for emphasis,
but be conservative - overuse of color is distracting.

» Creativity is important but there is a line
when it just becomes distracting.

» Pick a color scheme. Two to three related
colors will unify the poster.
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Use or Backgrounes

» Adding a background can take a poster from
basic to exceptional, but there is a fine line
between attention grabbing and distracting!

» Background options from safe to risky:

A solid color
A gradient of color
A simple repeating pattern

XXX

A picture with a monotone color palette

» Bad backgrounds are one of the biggest
mistakes you can make!!! It can ruin a
perfectly good poster.
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Seuare it yp

» When you are nearing the point when you
have your final format, make sure things are
even and square.

» The eye looks for equality and alighment and
is distracted when things are off




Identifying WRKY protein-protein interactions

PURDUE in Arabidopsis thaliana
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Effectiveness and Costs of Public Space Recycling in New York City

Abstract
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"‘ Determining the Relationship between GFAP. i
E g SPARC, and Msi-1 Expression in Axolotl Spinal Cord

) b Sarah T. Scott and Ellen A. G. Chernoff IUPUI
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ABSTRAC

The salomander Ambystama mexicana (axolotl) has the unique ability to completely regenerate an injured spinal cord ot any stage of ifs life. Once the cord is damaged, ependymal cells act as stem cells

disorganizing themselves in an epithelial to mesenchymal transition (EMT), and then rebuilding the cord in the mesenchymal to epithelial transition (MET). Previous research allowed us to discover that during these

transformations, three proteins appear and disappear. The first pratein is GFAP (Glial Fibrilary Acidic Protein, a cytoskelefal protein), which is present in the infact spinal cord [when the central canal is visible in the
regenerating cord). The second is SPARC (Secreted Protein, Acidic and Rich in Cysteine, o matricellular protein associated with injury), which is present in the epithelim, appearing when the epithelium is restored!
(MET). The third protein is Musashi-1 [Msi-1, a mRNA binding protein), which is present in the intact epithelium of embryo and juvenile axolotl, while absent in intact adult axolotl epithelium. Msi-1 up-regulates in the
mesenchymal sutgrawth in adult axolofl. We will defermine if GFAP, SPARC, and Msi-1 ever exist in the spinal cord at the same stage of regeneration. Using these three profeins as markers uriquely allows us fo
visualize the ependymal cells in the complex lesion site through the entire regenerative process.

My goal was to determine the presence of these three proteins using fluorescent immunohistochemistry. Transected sections of three and five week regenerating axolot! spinal cord were stained with GFAP and

SPARC antibody and under a | compared the photographs o determine whether GFAP and SPARC exist in the same stage of regeneration. Our lab has also studied the

presence of Msi-1 in the regenerating spinal cord and we compare it 1o the present research’s findings. We should be able to determine the proteins’ relationship after the comparisons.

BACKGROUND RESULTS AND DISCUSSION

We are researching the relationship between GFAP, SPARC, and Msi-1 expression in the regenerating # The results were expected = SPARC & GFAP are present in specific stages of regeneration.
GFAP and SPARC are present in @ complementary pattern.

axolotl/salamander spinal cord. Knowing the relationship among these ependymal cell markers will
allow us 1o visualize the ependymal cells through the entire regeneration process within o complex @ We were able to successfully label with GFAP, SPARC, and Msi.1 in the regenerating axolotl
wound site. The purpose of this research is 1o allow us 1o follow the ependymal cells in all of their forms spinol‘cord ar different noges of the proces:

of tissue organization during spinal cord regeneration in an species that regenerates successfully. # As of now, we have not mapped out the enfire regeneration process using these markers.
LITERATURE REVIEW However, we hove been able to compare SPARC and GFAP. We plan to compaore Msi-1, also.

# Amphibian regeneration of the lumbor transected spinal cord
regenerates via gap replacement.

* cells are ible for the ion of the
amphibian spinal cord.

4 Ependymal cells containing GFAP line the walls of the infact spinal
cord central canal.

# Musashi [Msi-1) is @ marker of activated neural stem/progenitor
cells and maintains Nofch signaling

# SPARC is @ matricellular protein that has the role of building
the extracellular matrix.

Figure 2: Unlike the infact cord, three week
Figure 1: GFAP i present inthe rodial glicl regencrating aolotl spinal card canfaing no low

m . ——

1) The transected and intfact spinal cards of
[the axoletl salamander) were used in this research project as subjects.

-1

We used fluorescent immunchistochemistry 1o stain sectioned
spinal cord tissue with GFAP, SPARC, and Msi-1 protein markers
(Red).

)

Sections were also stained with DAP|, (Blue) a DNA-binding molecule,
which allows us to see the nuclei of the ependymal cells.

4) Stained sections were viewed and photographed under

fluarescent microscope: A Nikan Eclipse EB00 microscope
was used o view ond
5) Red and blue channel images were merged using Photeshop. photograph stained sections. Figure 3: The infact adult axclotl cord lacks Figure 4: Msi-1 up-regulotes in the mesenchymal

the presences of ependymal cell Msi-1 ouigrowih affer fwo weeks of regeneration.

6) We compared the images of regenerating cord in the same stage with
determine if protein is present ot both stages.
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HOW O Present & Poster

» Know your RESEARCH!

» Know your RESULTS!

» Know your TECHNIQUES!
» Know your REASONS!

» Know your POSTER'




General Infermeation

» The typical poster reader will approach a poster,
stop, read, and move on in 90 seconds or less

» You need to attract and hold the reader until the
message in the poster is evident

» Have something to give people:

+ A brief summary of the poster
+ Your CV or resume with e-mail, website, mail address, etc.
+ Your business cards

+ An 8.5x11 print out of your poster with contact information on the
back




RESOUICES

» Mariah Judd, juddm@iupui.edu

» Website from the CRL
http://www.crl.iupui.edu/resources/poster-
design.asp

> General tips and guidelines as well as downloadable version of template
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Now lets learn HOW to
build an actual poster...




Tiriclks of the Trace

» PAGE SET UP This is the first thing that you will do.

This defines the parameters of the space that you
will be building your poster in.

» At the top of the screen click on “Design” then the
far left icon is “Page Setup” A typical poster is
something like 46-52 x 34-40. Check the guidelines
of the conference you are presenting at for the
maximum dimensions for a poster.

» Standard posters are landscape but sometimes a

profile poster will highlight your data better so keep)
it in mind.




Tiricks of {he Trace

» BOXES This is a great way to get a feel for the

»

layout of your poster. They make it easy to add color
to your poster and highlight your text. They are also
easily stylized.

On your “Home” tab in the “Drawing” section there
is a button called “Shapes”. By clicking on this
button it will pull down every shape you could
imagine. Select the one that you want (usually the
standard box or the box with rounded edges) then
oh your poster you can create your box by clicking
and pulling out until your box is the size that you
desire



Tiricks of {he Trace

» BOXES continued

» Now you can stylize your shape a number of ways.

> Select the box that you want to stylize and left click on
your mouse. Then select “format shape” at the very
bottom of the pull down box.

> From this screen you can change just about anything
you desire from the color to the transparency of your
shape to the shape outlines, color and thickness.

> Once you have gotten your shape how you like it, you
can copy and paste it over and over again to keep your
poster consistent



Tiricks of {he Trace

» TEXT BOXES these are very easy and necessary when
building a poster. | suggest that you make your “boxes”,
then overlay your text boxes over the boxes so that you
have more control over the margins and everything
else!!

» At the top of the page, select the “Insert” tab. Then
about half way over within the “text” section there is a
button called “text box”. Click on this button then on
your poster click where you want your text box to be and
start typing the text that you want.

> You can copy and paste text from another source and this
will automatically create a text box for you but you will more
than likely need to format it once you paste it into your )
poster.




Tiricks of the Traee

» TEXT BOXES continued

» Once you have your text, you can format the text by
highlighting the text that you want to format then
under the “Home” tab you can change the font, the
text size, bold, italicize, shadow, change the color
and even the spacing of your text.

» There are more advanced ways of enhancing your
text but usually for a poster you don’t want to over
stylize so these basic functions should be enough for
you to make a great poster. )




Tiricks of the Traee

» BACKGROUND This is a more advanced tool for bringing

»

»

your poster to the next level. A bad background can KILL an
otherwise good poster so if in doubt go without!!

An easy way to give your poster a basic solid color
background is to insert a giant “BOX” the size of your poster.

Once you have created the box, select the box, then at the

top of your screen click on the “Format” tab. Then towards
the left side of the banner within the “Arrange” section there
is a button called “Send to the Back” By clicking on this it will
send your box behind all other items on your poster. Above
“Send to Back” is “Bring to Front” this button can be used to
bring any item to the front of all other items. You might want
to use this button to bring your text forward or a graphic.
These buttons can be VERY helpful as you start to arrange all)
of your items.



Tiricks of the Traee

» BACKGROUND continued

» Another option with the background box is to add
some depth to it by making it a gradient or a texture.

» The most tricky background is using an actual
picture. The trick to making it work is making sure
that your text and graphics are what stand out the
most and not the background!!

» If you do use a picture, make sure that it will not
print pixilated. To check this, view the slide at 125%
and if it is viewable then it will probably print well.

)




Tiricks of the Traee

» FINISHING TOUCHES

» Before you send that baby to print, print it 8.5x11 and
check EVERYTHING. Check alignment, check spelling,
check language, check colors, check picture quality,
check proportions of fonts...check everything!

» Make multiple copies and hand it out to colleagues to
get their feedback.

» To do this, in PowerPoint, go to print and select “scale to
fit paper”. Depending on the version you have this could
be a box you check or an option in a drop down menu.

In the latest version, it is under “Full page slides” and it
an option you select. )

» | suggest always printing in color
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